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Limited Warranty

This software is provided ‘as is’, without warranty of any kind, either
expressed or implied, including but not limited to, the implied warranties of
fitness for a particular purpose.

Rising Software Australia Pty Ltd does not warrant that the functions
contained in the software will meet your requirements or that the operation
of the program will be uninterrupted or problem free. Rising Software
Australia Pty Ltd does not guarantee that the software will function as
documented, as expected or as promised. All risk as to the quality and
performance of the software is with you.

Rising Software Australia Pty Ltd does warrant that the physical medium
upon which the software (including documentation) that is provided will be
free from defects, assuming normal use, for a period of fourteen days from
the date of delivery. Rising Software Australia Pty Ltd will replace, free of
charge, these materials if notified within this period of fourteen days.
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Auralia Features Overview

Auralia contains 26 topics, covering areas such as Intervals, Chords, Scales,
Harmony, Rhythm, Melody, Jazz Chords and Tuning. Each topic has a
system of levels, allowing you and your students to work through Auralia’s
exercises in a progressive manner. Some topics also feature microphone
input, such as Interval Singing.

Auralia includes many features that make using Auralia in a classroom or
network environment very easy. We encourage you to use as many of these
functions as possible.

Firstly, Auralia enables you to track all your students results individually,
and you may have as many students enrolled in the program as you wish!
Numerous reports are built into Auralia, so that you may print out student
results when the need arises.

The Professor allows you to automate student progress. The Professor will
advise students when to move up and down through the levels, using
settings that you control. These settings are different for each class,
allowing great flexibility.

As a practise tool, Auralia excels, giving students a diverse selection of
exercises to choose from. The testing features give Auralia a number of
new applications. Tests have a predefined list of quesitons for students to
attempt. All test results are stored separately and you may create as many
tests as you desire. Tests can be used for exams and quizzes or simply to
customise Auralia to your particular teaching method.

Auralia 2.1 integrates with Musition 2.0, allowing your students to have
the same password and user name in both programs. On a multi user
network system (Desktop Site License required), this feature becomes even
more valuable.
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Topics

Selecting a Topic

Auralia contains four topic groups, identified by the four large buttons near
the top of your screen. Clicking on one of the topic groups will change the
topic buttons that are displayed below.

To select a topic, click on the topic button. You will then be shown a
‘Level Selection’ screen, where you will need to select a level.

Selecting a level

The method of selecting a level is identical for each topic. To choose a
level, simply click on ‘Level 1’ or similar in the level selection screen.
Auralia will then display a list of levels; click on the level that you wish to
use. If a minimum level has been set for your class and this topic, only that
level and above will be shown here. As you click on a level, the
accompanying description box will change to show the contents of the
selected level.

Some topics have ‘Custom Levels’, where you can choose a selection of
question types to be drilled on. This feature is very useful when trying to
eliminate a particular problem (eg. Minor 2nds and Major 2nds in the
Intervals topic).
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Information Screens

All topics have an accompanying Information screen. Basic concepts
regarding the topic are outlined, and examples are given. For example, the
Chord Recognition Information shows you notated examples of chords and
allows you to play the chords back. To enter the information screen, click
on the Info button when selecting a level. If you need help with the
information screen, click on Help.

You may also enter an information screen by using the ‘Information’ menu
from the main screen.

To Begin

To begin practising, click the ‘Start” button on the level selection screen. If
you decide not to proceed with the topic, you can click on the exit button to
leave the level selection screen or drill screen.

Using a Topic

When you have entered your answer, press OK. If you are practising,
Auralia will tell you whether you were right or wrong. If you were wrong,
you may be able to try again.

You can hear the question again (or the starting note for a singing topic) by
pressing the Replay button. When you are finished practising, or if you
wish to cancel the rest of your test, press Exit.
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The Auralia Screen

The ‘File’ Menu

Changing your details

Click on the ‘File -> Change Your Details’ menu to change your details.
You will be able to change your password, class and voicetype by selecting
the options provided If you are changing your password, note that you will
be required to type your new password twice.

NOTE: This function will only work if the ‘Use names and passwords’
securty option is enabled.

Viewing personal results

You can view your results by using the ‘File -> Check my results’ menu on
the main screen. This screen will give you immediate feedback on your
progress in any of the topics in Musition 2.0* and Auralia 2.1 for both tests
and practice.

*Musition 2.0 is Rising Software’s theory training software package which
can share user, class and database information and statistics with Auralia
2.1. The administration features for both programs can be set up here in
Auralia 2.1.

To check your progress for any of the topics, first select that topic from the
dropdown box. Then select the level for which you would like to view your
results.

Once you have entered this information, you will be shown the number of
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questions that you have attempted, and the percentage of these that you
have answered correctly for both tests and practice. You may also select a
‘date range’, to narrow the time period from which your results are selected.
Simply click on the date boxes to select a starting and finishing date for the
results you wish to view.

NOTE: This function will only work if the ‘Use names and passwords’
securty option is enabled.

Starting a Test

If there are tests available for you to attempt, use the ‘File -> Start Test’
menu to bring up the list of tests. A status bar below the list of tests will
indicate whether you have started or finished the test, and if the resume
function is available. If the resume function is available, you may stop
doing the test part of the way through, and then resume at the point where
you left off the next time you use Auralia!

NOTE: This function will only work if the ‘Use names and passwords’
securty option is enabled.

Toolbars

The two toolbars in Auralia give you certain controls while practising and
or testing. Most toolbar functions are only active when you are within a
topic’s drill screen. The exception is the volume control, which is always
active.

Changing Levels

The larger toolbar allows you to change between levels while practising in a
drill area. Depending on your current level, you can move either forward or
back, one level at a time. The current level is displayed on the left hand
side of the toolbar.

Auralia 2.1 User’s Guide 15

Scores

The larger toolbar also provides you with a current score tally and
percentage. This is reset each time you change level or topic.

Volume Control

The button on the far right of the toolbar will bring up the Windows mixer
or volume control when clicked upon. This will allow you to change
volume settings without leaving Auralia.

Tempo

The small toolbar on the right allows you to change the tempo of the current
example. For instance, if you were doing a rhythmic dictation exercise, and
it was a little too fast, you could slow it down by using the slide bar. The
metronome marking is indicated on the left hand side of the toolbar.

Information Screens

Information screens relating to each topic can also be accessed using the
‘Information” menu on the main screen.
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Sound

MIDI Setup

The MIDI setup screen allows you to control the way Auralia uses MIDI in
your system. From the main menu, select ‘Administration -> General ->
MIDI sound’ to open the MIDI setup screen.

Output Device
The ‘Output device’ box is where you select which device Auralia
will use for MIDI output. This is used to play examples of intervals,
chords and scales in these topics and their accompanying
information screens. To enable MIDI output, click on the box
provided.

To change the midi output device click on the ‘Open the Multimedia
Control Panel’ button. Click on the MIDI tab and then select one of
the devices from the list. To enable this new MIDI device you must
then click on the ‘Apply’ button followed by OK.

MIDI Thru / MIDI Input
This option, when enabled, allows MIDI Thru during practice. This
means that users will be able to play and hear sounds from a
keyboard (or similar MIDI device) whilst operating in Auralia.

To enable MIDI Thru, click on the box provided. To select your
desired MIDI input device simply select a device from the drop-
down box.

NOTE: You must exit the program and then re-enter for the changes made
under the MIDI tab to take effect.
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Correct and Incorrect Sounds

Auralia has the capacity to play ‘wave’ sounds, at certain times during a
session. These sounds require a sound card to be present in your system. If
you are using pure MIDI equipment, it is unlikely that these features will
work. To open the wave sound setup screen, select ‘Administration ->
General -> Wave sound’.

Option: Play Startup Sound
If this option is selected, a sound will play when Auralia is loaded.
This sound cannot be changed.

Option: Play Closing Sound
If this option is selected, a sound will play when Auralia is closed.
This sound cannot be changed.

Option: Play sounds for a correct answer
If this option is selected, when a student gets a question correct an
correct sound will be played. The sound will change each time,
chosen randomly from a selection.

Option: Play sounds for an incorrect answer
If this option is selected, when a student gets a question incorrect an
incorrect sound will be played. The sound will change each time,
chosen randomly from a selection.

Volume Levels

You may wish to change the balance of volume between the ‘correct’ and
‘incorrect” sounds (wave sound) and the volume level of the questions
(MIDI sound). You will firstly need to bring up the Windows mixer or
volume control, as outlined in the section above ‘The Toolbars’.

Adjust the levels in the MIDI section and the Wave section until they are to
your liking. Test the levels by completing some questions within the
Auralia program.

If a control marked ‘Wave’ or ‘MIDI” doesn’t appear, select ‘Options ->
Properties’ from the menu in the mixer. In the list of controls at the bottom



18 Rising Software

Auralia 2.1 User’s Guide 19

of the windows, ensure that “Wave’ and ‘MIDI’ both have checks in their
boxes. Click OK, and they will appear on the volume control.

NOTE: The MIDI sound control may also be known as ‘Synthesizer’ in the
mixer / volume control.

Using your Microphone

Auralia can listen to your singing and work out which note you have sung.
Sound2MIDI is the pitch recognition technology used in Auralia’s singing
topics, which are listed below;

* Interval Singing

* Scale Singing

* Advanced Scale Singing
* Chord Singing

* Counterpoint Singing

* Jazz Chord Singing

* Note Recognition

There are a few tricks to note when using these topics in Auralia.

Setting up the Microphone

In the Windows mixer, the microphone device needs to be selected for
recording. Load the mixer by double clicking on the speaker icon in the
group of icons in the bottom right of the screen, right of the Windows Start
menu. Change to recording properties by selecting Properties from the
Options menu, and then selecting ‘Adjust volume for: recording.” The
Microphone device should be checked (have a tick next to it), in the list of
volume controls. Then press OK. The ‘Select’ box for the microphone
device must be checked; if it is not, click on ‘Select’ to check it.

In the Playback Options, it is best if the microphone is muted while using
Auralia. However, you should uncheck the muted checkbox and speak into
your microphone to test that the volume is not too loud or too soft. Both of
these conditions will lower the accuracy of the note recognition in Auralia
and may make Auralia think your answer is incorrect.
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Singing hard syllables

Pitch recognition works best if you sing long but detached notes. You
should not sing legato (with your notes joined together); Auralia will not
recognise some of the notes you sing. It is best if you start each syllable
with a ‘Ma’ or ‘La’ sound; other sounds may make Auralia miss your notes
or detect the wrong note. Take your time when singing back your answers;
there is no time limit.

Other issues

If you receive the message ‘Driver halted — not enough power,’ this means
that your computer is not powerful enough to use the Sound2Midi pitch
recognition software. You may not be able to use the singing topics in
Auralia. A 486-66 or better is required for Sound2Midi. This error may also
occur if you are running some other application programs at the same time
as Auralia; we recommend that you close these applications while running
Auralia.
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Security & Logging In

Levels of Security

Auralia has a security system which, when enabled, provides users with
different levels of access to the program. The ‘Administration -> General
-> Security’ screen allows you to set the security level that you wish to use
and thereby define whether students, teachers and administrators will be
asked for a password upon entering Auralia.

Auralia allows three types of security. The most secure uses names and
passwords to identify individual users. It also uses an access level for each
user, and records each user’s voice type. In this setting, Auralia also records
statistics for all users. When users start Auralia they are asked for their
name and password. To enable this option, select ‘Use names and
passwords’. This setting is the optimum for use in schools, and may also be
useful in other situations if statistics are desired.

NOTE: You must have a user with administrator access defined in order to
activate this option. Open ‘Administration -> User Maintenance’ to add
such a user.

The second setting is to password-protect the Administration screens. If
you don’t need to use names and passwords (and don’t wish to record
student results), but need to prevent people from changing configuration
options, then click on ‘Password protection for administration functions’
and fill in a password in the box provided. When a user selects the
Administration menu, they are asked for this password. No password is
required to use and of the topics within Auralia. (This password is only
shown when you are editing it. At other times, asterisks will be shown for
security reasons.)

The final security option is to use ‘No security’. Anyone may use the
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administration program and change any of its settings. This setting is not
recommended when more than one person will be using Auralia.

To make one of the security settings active, click on the button next to it.

Single User Settings

The ‘Administration -> Users -> Single User Settings’ screen provides
options for Auralia when it is being run in a single user environment. The
settings on this page will take effect if you are not using the security option
‘Use names and passwords’. No student results are recorded with this
option disabled.

If you are using Auralia in a single user environment, select your voice
from the drop-down box provided. If you would like to be able retry
questions that you answer incorrectly, then tick the box. To exit the single
user settings screen click on OK.

Network File Security

Please consult the installation guide for information about files permissions
when using Auralia’s network database features.
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Recording Results

Auralia is capable of recording all results, allowing you to track individual
student progress. Results can be printed out, and you may also reset each
student’s scores when necessary.

An Introduction to Users and Classes

If you wish to record your students’ progress, they will each need to be
‘enrolled’ into Auralia and given a login name and password. Each student
will also need to belong to a class.

A class is simply a grouping of students. They are very much like the
classes found in a typical school environment If you are using Auralia in a
school, we recommend that you simply replicate your existing school class
structure within Auralia.

As a private teacher, you may wish to setup your own class structure to
group your students. Auralia has a built in class, called the ‘Default Class’,
which you can add your students to if you wish.

There are particular options that you can set for each class, giving you the
flexibility to tailor Auralia for different groups of students.

Enabling Logins and Record Keeping

To record your students progress, you must first ensure that the security
option ‘Use names and passwords’ has been chosen. This option is found
under the ‘Administration -> General -> Security’ menu. Before you can
enable this option, you must add an ‘Administrator’ user to the system,
which is explained in the following section entitled ‘Adding a New User’.



24 Rising Software

Description of the various security options are covered in detail in the
previous section entitled ‘Security and Logging In’.

Managing Users

The user maintenance screen allows you to add new users to your Auralia
configuration and change details of existing users, such as their passwords.
For each user, Auralia maintains the name of the user, their password, their
class, and an access level.

An access level sets the functions that a particular user may perform in the
Auralia system. Auralia has three levels of access. Student access will be
the most common; it allows people to use the Auralia program, but does not
allow any administration or configuration of the system. Teacher access
allows access to statistics and tests, but not to configuration, class or user
maintenance. Administrator access allows all of these functions. (Both
Teacher and Administrator access levels do also allow use of the Auralia
program itself)

Adding a New User

To add a new user, click on the Insert button. Select the Name box and
enter the name of the new user. Next, change to the Password box and
enter a password for the user. The password will only be shown when you
are editing it; asterisks will appear at other times.

Next, you should set the user’s class. Click on the Class box, and select a
class from the dropdown list. There will always be at least one class
available - the ‘Default Class’.

If this user is a teacher or an administrator, select their level of access from
the options provided. You must have at least one user with administrator
access if you have ‘Use names and passwords’ enabled in Auralia.

If you happen to be LOCKED OUT of the program, contact Rising
Software for further assistance.

When you are finished, press the Accept button. Your new user will then
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be ready. If you don’t want to save your new user, press the Undo button.

Deleting a User

Select the user and then press Delete. The user will then be removed from
the system.

Resetting a User’s Results

There may be a point in time where you wish to reset a user’s results. For
example, at the start of a new school year or at the start of a new semester.
Simply click on the button marked ‘Clear results for this user’.

Logging In

The login screen is used to identify all users and their access levels so that
statistics and administration functions can be used in Auralia. All users are
required to enter their name and password. New users may be able to
automatically enroll in the program; see ‘Automatic User Registration’,
below.

The login screen will only appear if the ‘Use names and passwords’, or
‘Password protection for administration functions’ security settings are
enabled.

User Administration Options

Automatic User Registration

If enabled, Auralia will allow users not manually added by an administrator
to login and be added to the user database. These new users will be given
Student access, and will not have access to teacher or administrator
functions. It is recommended that you enable this option in a school
environment to avoid adding each user individually to your system.
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NOTE: If Auralia is does not have ‘Use names and passwords’ enabled (see
Security & Logging In), this option will have no effect.

Allowing Users to Change their Settings

If this option is enabled, Auralia will allow people using the program to
change their password, class and voice type. If this is disabled, the user will
not be allowed to change these details.

NOTE: If Auralia is does not have ‘Use names and passwords’ enabled (see
Security & Logging In), this option will have no effect.

Recording Statistics

When this option is enabled, Auralia will record statistics about users’
progress during practice as well as during tests. These statistics can be
viewed using the reports.

NOTE: If Auralia is does not have ‘Use names and passwords’ enabled (see
Security & Logging In), this option will have no effect.

Managing Classes

The class maintenance screen allows you to add classes to your Auralia
configuration. You can also edit existing classes. For each class, Auralia
maintains the name of the class, it’s teacher and a variety of other settings.

Adding a New Class

Open the class maintenance screen from the main menu; ‘Administration ->
Classes -> Maintenance’. To add a new class, click on the Insert button.
You will then be able to enter the name and teacher of the new class, and set
the options. Click on the Name box and enter the name of the class.
Change to the Teacher box and select a teacher for this class. Select the
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other options as outlined below by simply clicking on the boxes.

Enable Professor for this class:
If this option is on, The Professor will be active. See the section
entitled ‘The Professor’ later in this guide.

Students may retry questions:
If this option is on, student in the selected class will be able to retry
a question if it is initially incorrect.

Use the student’s voice type:
If this option is on, the pitch topic will play examples in the vocal
range of the student. (When a user is enrolled, they are required to
enter their voice type. This option utilises that information.)

Choose appropriate instruments at random:
If this option is on, all the examples in Auralia will be played on
random instruments. Auralia will use General MIDI instruments
1-64.

Students may ignore their voice type:
If this option is enabled then students will be able to override the
voice type function if they wish.

To save your new class click on the Accept button and the class setting will
be saved. If you don’t wish to save your new class, press the Undo button.

Deleting a Class

Select the class from the list and then press the Delete button. Any users
who were in this class will not have a class set. You may wish to edit these
users in the user maintenance screen to move them into their proper class.

Resetting a Class’s Results

There may be a point in time where you wish to reset a class’s results. For
example, at the start of a new school year or at the start of a new semester.
Simply click on the button marked ‘Clear results for this class’.
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Minimum Levels

The minimum level setting for each topic sets the minimum level the
students of a class may attempt. For example, if you set the minimum level
for Intervals (Auralia 2.1) to level 3, students in this class will not be able to
use levels 1 or 2 of intervals. All minimum levels default to level 1,
allowing students to attempt all levels of the topic.

To set the minimum levels for a class, select the class from the list. Then
select a topic from the topic dropdown list. You may then specify the
minimum level and the number of retries for that topic in the spaces
provided. To set the minimum levels for a different topic simply select that
topic from the list and follow the above process.

To change any of the minimum levels, select the topic that you wish to
change. Select the level you wish to make the minimum by clicking on that
level.

Active Topics

It is possible to ‘turn off” topics for any particular class. This could be
especially useful for younger classes, where you may wish to ensure they
have focus on particular areas.

To set a topic active or inactive, use the ‘Administration -> Classes ->
Minimum Levels’ screen. Firstly, select the class from the list and then
choose the topic from the topic box below. On the right of the topic box,
there is a box called ‘Active Topic’. When the box is checked, the topic is
active, and will be available for students of the class to use.
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Testing and Customisation

Introduction to Tests

Tests are one of the most useful features of Auralia. They can be used for
setting up a quiz, an examination or simply to customise Auralia to your
particular teaching method. A test is really just a set of questions from
various topics that you wish your students to attempt.

When you create a test, the students who are in the class that the test is
created for all get the chance to do the test, without any intervention from
the teacher. Classes can have multiple tests assigned to them, and all the
results can be viewed on the ‘Reports -> Tests” menu. Each test has its
results stored separately.

If there are tests available for a students class when they login to Auralia,
they are given the option of doing the test, or proceeding into Auralia for a
normal practice session. Tests are only enabled if you have set Auralia to
‘Use names and passwords’.

Creating Tests

The test administration screen allows you to add tests to your Auralia setup.
You can also edit existing tests. For each test, you must specify a test
name, a class, and whether the test applies to Auralia or Musition.

Naming and Assigning aTest

Open the test administration screen by selecting ‘Administration -> Tests’
from the main menu. Click on the Insert button. You will then be able to
enter the name of the test, and select a class.
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Click on the Name box and enter the name of the test. Change to the Class
box and select a class from the list. Next select whether the test is for
Musition or Auralia by clicking on the relevant button.

If the box marked ‘Allow resumption of test’ is enabled, users will be able to
stop in the middle of the test, quit, and resume the test at a later date.

The other option available is whether you want Auralia to ‘Indicate correct
or incorrect answers’ during the test. If you wish Auralia to perform this
function, click on the button provided. To save the test, click on Accept.

To define the contents of the test click on the Edit Test Entries button. For
information on creating test entries read the following section ‘Adding Test
Entries’.

NOTE: If you are editing a test, and it has entries, you cannot change the
program that the test applies to.

Adding Test Entries

The test entries screen allows you to define what topics and levels form the
questions in the test.

You can enter this screen by clicking on the Edit Test Entries button from
the test administration screen, or by clicking on the Test Entries tab.

There are six simple steps when creating a test entry:
L. Select the test for which you wish to define the test entries.

2. Select the topic from the dropdown box. If you have set the test to
be for Musition or Auralia, then only the topics for that program will
be displayed.

3. Select the level from the level box.

NOTE: Musition and Auralia will provide default values for the
number of replays and the number of questions for each level of
each topic. Follow steps 4 and 5 below to change these values.

4. Select the number of replays from the replays box. This is the
number of times the student can replay the example while doing the
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test (Auralia only).

5. Select the number of questions. This is the number of questions that
the student will be asked before moving on to the next test entry.

6. Click on the Add button.
This entry will now be added to the Contents of Test list.

Repeat steps one to six above for each test entry you wish to create. Each
time you click on the Add button, the entry will appear in the box labelled
‘Contents of test’.

If you click on a test entry in the box labelled ‘Contents of test’, the Delete
button, Move Up and Move Down buttons will be enabled. These basically
describe themselves; the delete button will delete the entry, the move up
button will move the entry up the list and the move down button will move
the entry down the list.

Entries can be added or deleted from the test at any time by simply
following the above add and delete methods.

NOTE: If the test you are adding to has already been attempted by students,
the students’ results will no longer be complete. Musition will warn you of
this when you press Accept. Your students will have to resume the test to
complete it. (Resumption of the test will be switched on automatically).

Starting a Test

If there are test(s) available for students they will be prompted after they
login. They then need to select a test from the ‘File -> Start Test” menu.
Auralia will then lead them through the test.

Deleting Tests

Select the test from the list and then press the Delete button. Any results
that were available for the test will be lost.

NOTE: If the test you are editing has already been attempted by students,
any results for the test will be lost when you delete it. Auralia will warn
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you of this when you press Delete.

Resetting Test Results

There may be a point in time where you wish to reset a test’s results. For
example, if you have a test setup as a sequence of drills that the students are
required to complete on a weekly basis. It is much simpler to reset the
results than to recreate the test! Simply click on the button marked ‘Clear
results for this test’ to reset all the results.

Topic Customisation

Terminology

If you wish to use British terminology instead of American terminolgy
check the box marked ‘Use the term “crotchet” instead of “quarter note”
etc’. This will apply throughout the program.

Chords

The custom topics screen allows you to add new chords to Auralia. These
chords are used in the Chord Recognition and Chord Singing topics.

Adding New Chords

To add a new chord to the database, click on the Insert button, give the new
chord a name and set the minimum level for which you want it to appear.
Then simply click the chord in on the keyboard provided and it will be
notated on the staff. To enter the note as a sharp, natural, flat, double-sharp
or double-flat simply click on that button prior to clicking in a note on the
keyboard. If you have entered the chord incorrectly, click on the Clear
button and then re-enter the chord.

To save this new chord click on Accept. If you do not wish to save the
chord click on Undo.
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Editing Existing Chords

To edit an existing chord, select the chord that you wish to change and then
click on the edit button. You can then add notes to the chord by clicking
them in on the keyboard, or re-enter the entire chord after first clicking on
the Clear button. To save this new chord click on Accept. If you do not
wish to save the chord click on Undo.

You can also delete chords from the database by selecting the chord and
then clicking on the Delete button.

OtherTopics
Some other topics in Auralia have options which you can set on this page.

Scales, Advanced Scales, Interval Recognition, Chord Recognition and
Jazz Chords all ask the student to recognise a particular scale, interval,
chord, etc. However, as an added challenge the student can also play the
scale, interval or chord back on the keyboard. If the ‘Use on-screen
keyboard’ option is selected, a piano keyboard will be shown on the screen
and students can play back their answers on this keyboard using the mouse.
You can also select ‘Use MIDI keyboard’ to allow these answers to be
entered on a MIDI keyboard attached to the computer.

Note: the starting note for the interval, chord etc is shown on the on-screen
keyboard. If you enable the MIDI keyboard but not the on-screen keyboard,
students will not be shown the starting note.

Rhythm Dictation and Rhythm Element Dictation both have a count-in
before the rhythm starts, and a metronome while the rhythm is played. A
student can turn the metronome off by clicking on the ‘Play Metronome’
option in the topic. However, you can also disable metronomes completely
in these topics by clicking on the ‘Use Metronome in Rhythm Dictation and
Rhythm Element Dictation’ option so that it is unchecked. Students will not
be able to turn on the metronome. The count-in is still played. The
metronome is always played during rhythm imitation, and never played
during meter recognition.

A metronome is also played during melodic dictation. You can disable the
metronome by turning off the ‘Use Metronome in Melodic Dictation’
option.
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Emphasis

All rhythm topics have an emphasis played on the major beats of each bar.
You can increase or decrease the amount of emphasis on these beats by
moving the slide bar with the mouse. Use the ‘Test’ button to hear an
example of rhythm played with the changed emphasis. It may be necessary
to increase or decrease the emphasis if it is not easily heard on your sound
card or if it makes it difficult to hear the other parts of the rhythm.

Similarly you can increase the emphasis on the bass line in chord
progressions, advanced chord progressions, jazz chord progressions and
cadences by moving the chords slide bar. The test button will play an
example cadence with the emphasis you have chosen.
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The Professor

Who is The Professor?

The Professor can be thought of as a teachers assistant. He is there to help
students move up and down through the levels of each topic. For example,
you may wish your students to advance a level as soon as they are getting at
least 75% of questions correct. The Professor can automate this process for
you, either by giving your students a reminder to move up a level, or
enforcing the move up a level.

It is also possible to have your students asked to move down a level using
The Professor. The same logic applies; if a student is getting less than a
specified percentage correct, The Professor can ask the students to move
down a level or enforce a downward move.

You also need to set a minimum number of questions that you would like
attempted in each level before The Professor makes recommendations.

NOTE: The Professor can only be active if the ‘Use names and passwords’
security option is enabled.

Enabling The Professor

The Professor is setup on a class by class basis, giving great flexibility in
the way you implement goals and hurdles for your students. The Professor
has default values, so that you may quickly turn the feature on, without any
further setup. The default values are shown below:

Level Up Threshold - 80%
Level Down Threshold - 30%
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Minimum Number of Questions to be Attempted - 15

Turning the professor on is done in the ‘Administration -> Classes ->

Maintenance’ screen, using the box marked ‘Enable Professor for this class’.

Customising The Professor

As previously mentioned, The Professor has default settings. If you wish to
change the settings, use the ‘Administration -> Classes -> The Professor’
screen.

For each class, it is possible to have separate settings per topic, or you may
have one set of settings applying to every topic. If you wish to have
different settings for only one or two topics, the default values will be used
for the others.

To change the default values, firstly select a class using the dropdown list
at the top of the screen. You must now decide if you want to have
individual settings for each topic. Choose from the buttons marked ‘Use
the SAME settings for each topic’ and ‘Use INDIVIDUAL settings for each
topic’.

The setup is then the same; except that you must also pick the topics you
wish to change if you selected the ‘Use INDIVIDUAL settings for each
topic’ button. You will need to set the ‘Level Up Threshold’, ‘Level Down
Threshold” and ‘Minimum Number of Questions to be Attempted’. Simply
type your desired values into the boxes.

Professor Options

On the same ‘Administration -> Classes -> Professor’ screen, there is an
option entitled ‘Allow students to ignore professors advice’. If this is
enabled, students will be able to ignore the advice of the professor when he
pops up during their practise sessions. This option applies regardless of
whether you use the same settings for each topic.
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Obtaining Results and Reports

Introduction

The reports screen allows you to find out information on all of the
program’s users and observe your students’ progress in both tests and
practice. Auralia can only record statistics and track users and classes if the
‘Use Names and Passwords’ security option is being used.

List Reports

The List reports give you information about the users, passwords, voice
types, classes, and the tests that have been set up within Musition and
Auralia.

User Result Reports

The User Statistics reports give you information about a specific user’s
progress in both tests and practice for any of the topics and levels in
Musition and Auralia.

Class Result Reports

The Class Statistics reports give you information about all the users’
progress (in a particular class) in both tests and practice for any of the topics
and levels in Musition and Auralia.
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Test Result Reports

The Test Statistics reports give you information about a specific user’s or
class’s progress in tests for any of the topics and entries in Musition and
Auralia.

Using and Printing Reports

To select one of these report types, simply choose it from the
‘Administration -> Reports” menu. Once you have selected a report type,
you will be presented with a list of different formats which can be adopted.
The information that is contained in each of these formats is explained in
detail further down the page. To select one of these report formats click on
it and then click on the Next button. Depending on the report format, you
may be asked to select users, classes, tests, entries, topics or levels from the
drop-down boxes that appear. Click on next after making a selection for
any of the above.

In some reports, you may also select a ‘date range’, to narrow the time
period from which the results are selected. Simply click on the date boxes
to select a starting and finishing date for the results you wish to view.
Otherwise, select ‘Display all results’ from the options. Click on the next
button to continue.

At this stage Auralia will ask you what paper size you would like to use :
A4 or Letter. To select one of these paper sizes, click on it.

After completing the above process, you will be asked if you would like to
view the report before printing. To view the report click on Yes, if you
wish to print immediately click on No. If you choose to view the report the
following information and options will be available to you.

The number of pages to be printed will be shown in the bottom left corner
of the screen. To preview any of these pages, simply move through them
by clicking on the left and right arrows on the tool bar.

To change the print setup, click on the print setup icon on the tool bar and
the print options screen will be displayed.
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The report can be saved to file by clicking on the save icon on the tool bar
and then selecting the destination. Similarly, a report can be loaded onto
the screen by clicking on the load icon on the tool bar.

To print, click on the printer icon in the tool bar at the top of the page.
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About the Individual Topics

ﬂw.p%m:oma Chord Progressions

In Advanced Chord Progressions, Auralia will play a progression of chords
and ask you to identify it. A tonic chord is played before the progression
begins, but is not part of the progression. Chromatic harmony is introduced

here, and all chord from the Chord Progressions topic are used.

Level Added Chords Keys
Level 1 Mixture Chords Major Keys
Level 2 Major & Minor Keys
Level 3 VII - Diminished Major & Minor Keys
Level 4 VII - Half Diminished Major & Minor Keys
Level 5 Applied V Major & Minor Keys
Level 6 Applied VII Major & Minor Keys
Level 7 Neopolitan 6ths [Phrygian 1I'2] |Minor Keys
Level 8 Augmented 6ths - Italian Minor Keys
Level 9 Augmented 6ths - French Minor Keys
Level 10 Augmented 6ths - German Minor Keys
Level 11 Augmented 6ths - ALL Major & Minor Keys
Level 12 |Augmented Triads Major & Minor Keys

There are ‘boxes’ on the screen for you to enter your answer. Each chord
goes into a separate box. The chord box that you are currently working on
is highlighted with a black border. To enter the chord for a particular box,
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click on the chord’s symbol button. The next chord box is automatically
highlighted. You can change a chord you have already entered by clicking
on the box and pressing the button for the appropriate chord. Use the ‘Root
position’, ‘First Inversion’ and ‘Second Inversion’ buttons to set the
inversion for the chord you are adding or changing. You can set the
chord’s type (Unaltered, Augmented Triad or Mixture) by clicking on the
type buttons.

%.»%m:oma Scales

In Advanced Scales, Auralia will play a scale and ask you to identify it.

Level Content

Level 1 |Lydian Dominant, Lydian Augmented
Level 2 |Augmented, Diminished, Major (b6)
Level 3  |Diminished Wholetone, Lochrian (#2), Spanish Scale

Level 4 |Dorian (b2), Dominant Pentatonic, Minor 6 Pentatonic

In Advanced Scales, you will also notice that a piano keyboard is shown.
When Auralia plays a scale, the first note is shown on the keyboard. You
can also answer the question by playing the entire scale, either on the
keyboard on the screen, or on your MIDI keyboard. (Your teacher or
administrator may have turned off this option.)

m&.}%m:oma Scale Singing

In Advanced Scale Singing, Auralia will play a note and ask you to sing an
advanced scale starting on that note. Press the Start button, then sing the
scale. When you have finished singing the scale, Auralia will stop
automatically and tell you whether your answer was correct or incorrect. If
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Auralia does not seem to stop, then you have not sung enough notes! Some
lights on the screen show how many notes have been recognised. If it seems -w Chord Progressions
to be incorrect, you can press ‘Start again’ to reset and start over.

In Chord Progressions, Auralia will play a progression of chords and ask
you to identify it. A tonic chord is played before the progression begins, but
is not part of the progression.

Advanced Scale Singing has the same level structure as Advanced Scales.

MOmnmsomm
Level Content
In Cadences, Auralia will play a cadence and ask you to identify it. In some Level 1 I, V - Major Keys
levels the cadence is played after a short tune. When you have identified the Level 2 L, V, V7 - Major Keys
cadence, click on its name in the left panel and press OK. Some levels play — - -
a tune with two cadences; in this case you will need to select a cadence Level 3 L V, V7 - Major and Minor Keys
from the right panel as well as the left. A tonic chord is played before each Level 4 I, 1V, V, V7 - All Major Keys
question. Level 5 I, IV, V, V7 - All Major &amp; Minor Keys
Level 6 L, 16, 164, 1V, V, V7 - Major and Minor
I, 16, 164, 1V, V, V6, V64, V7, V65, V43, V42 - Maj
Level Content Level 7 g oY ’ ’ aor
and Minor Keys
Level 1 Perfect and plagal cadences played in major keys. L 16. 164 IV. IV6. IV64. V. V6. V64. V7. V65. V43
Level 2 Adds minor keys. Level 8 V42 - Major and Minor Keys
Level 3 Adds interrupted cadences, in major keys only. Level 9 L, 16, 164, TV, IV6, IV64, V, V6, V64, V7, V65, V43,
eve .
Level 4 Add minor keys for everything else. V42, VI - Major Keys
Level 5 Add imperfect cadence. All major keys. Level 10 L, 16, 164, 1V, IV6, IV64, V, V6, V64, V7, V65, V43,

V42, VI - Major and Minor keys
L, 16, 164, 11, IV, IV6, IV64, V, V6, V64, V7, V65, V43,

Level 6 Add minor keys for everything again

. . . f} "
Level 7 Uses Bo_o&o.m Emao.ma of Emﬁ. plonk, plonk!". All four Level 11 V42, VI - Major and Minor keys
cadences, all in major and minor
: . L, 16, 164, 1I (major), 1163, 1164, 1V, IV6, IV64, V, V6,
Level 8 Two cadences heard. One in the middle, and one at the Level 12 V64, V7, V65, V43, V42, VI - Major and Minor keys

end of the melody

I, 16, 164, II (major), 1163, 1164, IV, IV6, IV64, V, V6,
Level 13 V764, V7, V65, V43, V42, VII, VII6, VII64 - Major
and Minor Keys
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There are ‘boxes’ on the screen for you to enter your answer. Each chord
goes into a separate box. The chord box that you are currently working on
is highlighted with a black border. To enter the chord for a particular box,
click on the chord’s symbol button. The next chord box is automatically
highlighted. You can change a chord you have already entered by clicking
on the box and pressing the button for the appropriate chord. Use the ‘Root
position’, ‘First Inversion” and ‘Second Inversion’ buttons to set the
inversion for the chord you are adding or changing.

% Chord Recognition

In Chord Recognition, Auralia will play a chord and ask you to identify it.
When you have identified it, select it from the list of chords on screen, then
press OK.

Level Content
Level 1 Major and Minor in root position.
Level 2 Major and Minor in all inversions
Level 3 Add Dominant 7th in root position
Level 4 Major, Minor and Dominant 7th in all inversions.
Level 5 Add augmented and diminished chords in root position

In Chords, you will also notice that a piano keyboard is shown. When
Auralia plays a chord, the first note is shown on the keyboard. You can also
answer the question by playing the entire chord, either on the keyboard on
the screen, or on your MIDI keyboard. The first note is not necessarily the
tonic of the chord. (Your teacher or administrator may have turned off this
option.)
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wo_doa Singing

In Chord Singing, Auralia will play a note and ask you to sing a chord. The
note played is the tonic of the chord, which may or may not be the starting
note of the chord. (For a chord in first, second or third inversion, the given
note is the tonic, which is note the first note of the chord). The chord
required is shown on the screen.

Press the Start button, then sing the chord, ascending. Auralia will stop
automatically when you have sung the chord and tell you whether your
answer was correct or incorrect. If Auralia does not seem to stop, then it did
not detect your singing or you did not sing enough notes. See the ‘Using
your microphone’ section earlier in this guide for singing tips. Some lights
on the screen show how many notes have been recognised. If it seems to be
incorrect, you can press ‘Start again’ to reset and start over.

Chord Singing has the same level structure as Chord Recognition.

w Cluster Chords

In Cluster Chords, Auralia will play a sequence of chords and ask you to
enter it. The chords are all built on intervals of the second and the fourth.
The number of chords in the sequence depends on which level you are
practising or testing.

Level Content
Level 1 Given note and 1 chord
Level 2 Given note and 2 chords
Level 3 Given note and 3 chords
Given note and 4 chords. The fourth chord does not add
Level 4 another note, but changes two notes from the third
chord.
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To enter your answer, move the mouse over the staff and click on the note
you wish to add. You can set whether the note is to be added in its natural,
sharpened or flattened form by using the Flat, Natural or Sharp buttons. To
remove a note which you have added, click on it again. (You do not need to
have the same Flat, Sharp or Natural button selected to remove a note.)

.‘oo:im_ﬁomi Singing

In Counterpoint Singing, Auralia will play a short two-part phrase and ask
you to sing either the upper notes or the lower notes. Press the Start button,
then sing the the melody. When you have finished singing, Auralia will
stop automatically and tell you whether your answer was correct or
incorrect. If Auralia does not seem to stop, then you have not sung enough
notes! Some lights on the screen show how many notes have been
recognised. If it seems to be incorrect, you can press ‘Start again’ to reset
and start over.

Level Content

Short, slow melodies. 2 part. No more than 4 notes to

Level 1 sing back. Lines a fair way apart. Sing Soprano line.

Level 2 Add singing of bass line

A little faster. 3 bars, lines getting closer. Both bass and

Level 3

soprano.
Level 4 Faster still, 6 bars long. Close lines.
Level 5 6 bars long, close lines, register transfers.

mm Interval Comparison

In Interval Comparison, Auralia will play two intervals and ask you which
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interval was larger. Read the question carefully; Auralia may ask you which
interval was larger (first or second), or was the first interval larger or smaller
than the second, or was the second interval larger or smaller than the first.

Click on the answer which you think is correct, then press OK. If you are
practising, Auralia will tell you whether you were right or wrong. If you
were wrong, you may be able to try again. (If you are doing a test, your
teacher may have told Auralia not to tell you whether you were right or
wrong.)

You can hear the question again by pressing the Replay button. When you
are finished practising, or if you wish to cancel the rest of your test, press
Exit.

m Interval Recognition

In Interval Recognition, Auralia will play an interval and ask you to identify
it. You will also notice that a piano keyboard is shown. When Auralia plays
an interval, the first note of the interval is shown on the keyboard. You can
also answer the question by playing the second note of the interval either on
the keyboard on the screen, or on your MIDI keyboard. (Your teacher or
administrator may have turned off this option.)
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Level Content
Level 1 Perfect 4ths, 5ths, 8ves, ascending.
Level 2 Adds descending for all intervals.
Level 3 Adds maj 2nds, 3rds. All intervals ascending.
Level 4 Adds descending for all intervals.
Level 5 Adds BF 2nds, wﬁm and tritone. Ascending and
descending for all intervals.
Level 6 Adds maj and min 6ths. Ascending and descending for

all intervals.

Level 7 Add maj and min 7ths. Ascending and descending.

All regular intervals, ascending and descending, with
melodies.

Level 9 Add maj 10ths, perf 11ths, perf 12ths
Level 10 Add maj 9ths, min 10, maj 13

Level 11 Add min 9ths, comp. tritone (#11), min 13
Level 12 Add maj and min 14ths.

Level 8

Level 13 All intervals, ascending and descending.
Intervals played at the beginning or ending of a melody.
Level 14 . . .
All intervals, ascending and descending.
= ..
w‘_sﬁm_ém_ Singing

In Interval Singing, Auralia will play a note and ask you to sing a the note a
certain interval above it or below. The interval and the direction required
are shown on the screen. Press the Start button, then sing the interval.
Auralia will stop automatically when you have sung the interval and tell
you whether your answer was correct or incorrect. If Auralia does not seem
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to stop, then it did not detect your singing. See the ‘Using your
microphone’ section earlier in this guide for singing tips.

Interval Singing has the same level structure as Interval Recognition.

MW._NNN Chord Progressions

In Jazz Chord Progressions, Auralia will play a progression of chords and
ask you to identify it. A major or minor triad will be played before the
progression begins, but is not part of the progression.

Level Content
Level 1 '2-5-1" and turnaround progressions.
Some common extensions and variations are added to
Level 2 , , .
2-5-1" and turnaround progressions
Level 3 Altered dominants, '2-5-1's in minor keys and some '3-
6-2-5-1' progressions are added.
Some common progressions from jazz standards are
Level 4 added, in addition to some more altered '2-5-1'
progressions.
Some less common turnaround progressions and some
Level 5 . .
extra jazz standard progressions are added.
'2-5-1' substitutions, and some less common jazz
Level 6 .
standard progressions are added.
Level 7 adds slash chord progressions. Cycle of 4ths
Level 7 . .
and chromatic movements are also introduced.
Coltrane changes and advanced minor '2-5-1'
Level 8 .
progressions are added.

There are ‘boxes’ on the screen for you to enter your answer. Each chord
goes into a separate box. The chord box that you are currently working on
is highlighted with a black border. To enter the chord for a particular box,
select the key of the chord from the keys box, any alterations to the chord
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(such as m7 or 9) from the alterations box, and any slash note as necessary,
then press the Set button. The next chord box is automatically highlighted.
You can change a chord you have already entered by clicking on the box,
choosing the correct chord as before, then pressing Set again.

Mmgmnn Chords

In Jazz Chords, Auralia will play a jazz chord and ask you to identify it.
When you have identified it, select it from the list of chords on screen, then
press OK.

In Jazz Chords, you will also notice that a piano keyboard is shown. When
Auralia plays a chord, the first note is shown on the keyboard. You can also
answer the question by playing the entire chord, either on the keyboard on
the screen, or on your MIDI keyboard. Note: the first note is not necessarily
the tonic of the chord. (Your teacher or administrator may have turned off
this option.)

Level Content
Level 1 Major, Minor, Dominant, Dominant 7th, Major 7, Sus 4
Level 2 Diminished, Diminished 7th, Dominant 7th, Minor 7
eve and Augmented are added.
Level 3 Add - Augmented 7th, Major (add 9), 9th, Major 9, half
eve diminished and Major 6th are added.
Level 4 Major 7 (sharp 5), Minor 9, Quartal and 7 13 flat 9 are
added.
7 flat 13, minor 7 flat 5 (9), Augmented 7 (sharp 11), 7
Level 5 (sharp 11), minor (major 7) and minor (major 9) are
added.
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ﬁgmnn Chord Singing

In Jazz Chord Singing, Auralia will play a note and ask you to sing a chord.
The note played is the tonic of the chord, which may or may not be the
starting note of the chord. (For a chord in first, second or third inversion,
the given note is the tonic, which is note the first note of the chord). The
chord required is shown on the screen.

Press the Start button, then sing the chord, ascending. Auralia will stop
automatically when you have sung the chord and tell you whether your
answer was correct or incorrect. If Auralia does not seem to stop, then it did
not detect your singing or you did not sing enough notes. See the ‘Using
your microphone’ section earlier in this guide for singing tips. Some lights
on the screen show how many notes have been recognised. If it seems to be
incorrect, you can press ‘Start again’ to reset and start over.

Jazz Chord Singing has the same level structure as Jazz Chords.

%_sm_o&o Dictation

In Melodic Dictation, Auralia will play a one bar count in followed by a
four bar melodic excerpt. You must dictate the melody back to Auralia. The
meter (time signature) and key signature of the melody is shown on the
screen. The starting note is also shown and played before the melody
begins.

To enter the melody, click on the note length you wish to add, then click
where you wish to add it. You can add a note between two existing notes by
clicking in between the two notes. Press the Dotted button if you wish to
add dotted notes; press it again to stop adding dotted notes. To remove a
note you have added, press the eraser button (between the note duration
buttons and the dotted button). You can change the length of a note you
have added by selecting the new length and clicking on the existing note, or
by using the eraser tool to remove the old note and then add the new one.
You can change a note by clicking in what you want it to be on the same
spot as the old note



Level Length Max. Int. | Time Sig. Content Note Types
Whole notes, half notes, dotted half notes,
Level 1|4 notes/2 bars [Maj 2nd |3/4, 4/4 |1st three notes of major scale and quarter notes (semibreves, minims,
dotted minims and crotchets)
Level 2|6 notes/2 bars |Maj 3rd |3/4, 4/4 |lst five notes of major scale As for level 1
. Ist five notes of major and
Level 3|6 notes/2 bars |Maj 3rd |3/4, 4/4 . As for level 2
harmonic minor scales
All notes from major and harmonic
Level 4 |8 notes/2 bars |Perf 4th |3/4, 4/4 . As for level 3
minor scales
6/8, 3/4, |All notes from major and harmonic | Eighth notes and dotted quarter notes are
Level 5|10 notes/2 bars |Perf 5th .
4/4 minor scales added (quavers and dotted crotchets)
6/8, 3/4, |All notes from major and harmonic
Level 6 |10 notes/2 bars |Perf 8ve . As for level 5
4/4 minor scales
6/8, 3/4, |All notes from major and harmonic |Sixteenth notes and dotted eighth notes are
Level 7|4 bars Perf 8ve . i
4/4 minor scales added (semi-quavers and dotted quavers)
6/8. 3/4 All notes from major and harmonic
Level 8 |4 bars Maj 9th 4/4’ ” | minor scales. These melodies are | As for level 7
considerably more difficult.
All notes from major and harmonic
. 6/8, 3/4, |minor scales. These melodies are
Level 9 |4 bars Maj 9th . . As for level 8
4/4 considerably more difficult. No key
signature is provided.
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Level Content
Level 1 Sing the higher note of a two note chord.
Level 2 Add lower note.
Level 3 Sing the bottom, top or middle note of a three note
chord
Level 4 Sing the tonic note of a three note chord

Press the Start button, then sing the note. When you have finished singing,
Auralia will stop automatically and tell you whether your answer was
correct or incorrect. If Auralia does not seem to stop, it has not detected
your singing. See the ‘Using your microphone’ section earlier in this guide
for singing tips.

m,u\ Rhythm Dictation

In Rhythm Dictation, Auralia will play a one bar count in followed by a
four bar rhythm excerpt. You must dictate the rhythm back to Auralia. The
meter (time signature) of the rhythm is shown on the screen.

To enter the rhythm, click on the note length you wish to add, then click
where you wish to add it. You can add a note between two existing notes by
clicking in between the two notes. Press the Dotted button if you wish to
add dotted notes; press it again to stop adding dotted notes. Press the Rest
button to add rests, and press it again to return to adding notes. To remove a
note you have added, press the eraser button (between the rhythm buttons
and the dotted button). You can change the length of a note you have added
by selecting the new length and clicking on the existing note, or by using
the eraser tool to remove the old note and then add the new one.
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Level Notes Time Sig. Sounds
Whole notes, half notes and quarter
Level 1 [notes (Semibreves, minims, 2/4 and 4/4 |Percussion
crotchets)

Percussion and

Level 2 |Half note rests added (Minim rests) |3/4 added.

Instrumental

Eighth notes and quarter note rests

Percussion and

Level 3 As in level 2

added (Quavers and crotchet rests) Instrumental

Eighth note rests added (Quaver . Percussion, Instrumental
Level 4 As in level 3 R

rests) and Melodies

Dotted quarter notes and dotted
eighth notes added. (Dotted
Level 5 [crotchets and dotted quavers). All  |Adds 6/8

Percussion and

Instrumental
rests removed for the compound
time examples.
Dotted quarter note rests added Percussion and
Level 6 9/8 added.
(Dotted crotchet rests). Instrumental

Sixteenth notes and eighth note
Level 7 |rests added (Semiquavers and 12/8 added.
quaver rests)

Percussion, Instrumental
and Melodies

Dotted eighth notes added (Dotted . Percussion, Instrumental
Level 8 As in level 7 .

quavers) and Melodies

Eighth note triplets added (Quaver . Percussion, Instrumental
Level 9 X As in level 8 .

triplets) and Melodies

Sixteenth note rests added .
Percussion, Instrumental

Level 10 |(Semiquaver rests). All examples As in level 9 .
and Melodies

generally more difficult.

A metronome will be played during the rhythm, as well as a count-in before
the rhythm starts. You can turn off the metronome by clicking on the ‘Play
metronome’ box until it is not checked. This option will be unavailable
(grayed out) if your teacher or supervisor has turned off metronomes for
this topic.
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,Mvmmwwsﬁsq: Elements

In Rhythm Elements, Auralia will play a one beat long rhythm pattern
(preceded by a two beat count in). The student has to identify it from a
given selection.

Level Content

Four basic rhythms in simple time. Eighth notes and
Level 1 . .

sixteenth notes (Quavers and semiquavers)

Four more rhythms are added, using dotted notes and
Level 2 .

syncopation.

Four basic rhythms in compound time. Quarter notes,
Level 3 eighth notes and sixteenth notes (Crotchets, quavers and

semiquavers)
Level 4 Four more rhythms added, including syncopation.
Level 5 Rhythms from each level are used.

. uﬁw_usﬁsa Element Dictation

In Rhythm Element Dictation, Auralia will play a series of 1 beat thythm
patterns and ask you to identify the complete example.

There are ‘boxes’ on the screen for you to enter your answer. Each rhythm
element goes into a separate box. The box that you are currently working on
is highlighted with a black border. To enter the element for a particular box,
click on element’s button at the bottom of the page. The next box is
automatically highlighted. You can change an element you have already
entered by clicking on the box and pressing the button for the new element.

A metronome will be played during the rhythm, as well as a count-in before
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the rhythm starts. You can turn off the metronome by clicking on the ‘Play
metronome’ box until it is not checked. This option will be unavailable
(grayed out) if your teacher or supervisor has turned off metronomes for
this topic.

Rhythm Element Dictation has the same level structure as Rhythm
Elements.

[r5i Rhythm Imitation

In Rhythm Imitation, Auralia will play a rhythm and ask you to tap it back
on the keyboard. Listen carefully to the rhythm; after it has finished
playing, a metronome will be played. You can start to tap back the rhythm
whenever you are ready.

The ‘Tap’ button on the page will be automatically selected. Tap back the
rhythm using the space bar. You can also tap back the rhythm by using the
mouse to click on the Tap button, but this is less accurate and may lead to
wrong answers. The metronome will continue to play while you tap back
the rhythm. Note that you only need to tap for the start of each note; you do
not need to (and should not) hold the button down for half notes (minims)
and other longer notes. After you have finished tapping the rhythm, just
wait. Auralia will automatically stop the metronome and check your answer
two seconds after your last tap.

You can also tap the rhythm on a MIDI keyboard if you have one attached
to your computer. You can use any key on the keyboard. Like the computer
keyboard, you should not hold down long notes, but simple hit the key on
the start of each note.

Rhythm Imitation uses the same level structure as Rhythm Dictation.
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B
uu&@ﬂ:ﬁsa Styles

In Rhythm Styles, Auralia will play a short musical excerpt and ask you to
identify its style.

Level Content
Level 1 Rock (ballad 12/8), Rock (even 8ths) or Waltz
Level 2 Disco, Reggae and Rock (shuffle) are added
Level 3 Early Jazz, Rap and Swing are added
Level 4 Bossa Nova and Cha-cha are added
Level 5 Tango, Jazz Waltz and Samba are added.

%mg_mm

In Scales, Auralia will play a scale and ask you to identify it.

In Scales, you will also notice that a piano keyboard is shown. When
Auralia plays a scale, the first note is shown on the keyboard. You can also
answer the question by playing the entire scale, either on the keyboard on
the screen, or on your MIDI keyboard. (Your teacher or administrator may
have turned off this option.)
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Level Content

Level 1 Major and Harmonic Minor
Level 2 Melodic Minor is added
Level 3 Natural Minor (Aeolian) is added

Level 4 Chromatic and wholetone are added

Level 5 Pentatonic, Minor Pentatonic and Blues are added

Level 6 Dorian and Phrygian added

Level 7 Lydian and Mixolydian are added
Level 8 Lochrian is added

E‘mnm_m Singing

In Scale Singing, Auralia will play a note and ask you to sing a scale
starting on that note. Press the Start button, then sing the scale. When you
have finished singing the scale, Auralia will stop automatically and tell you
whether your answer was correct or incorrect. If Auralia does not seem to
stop, then you have not sung enough notes! Some lights on the screen show
how many notes have been recognised. If it seems to be incorrect, you can
press ‘Start again’ to reset and start over. See the ‘Using your microphone’
section earlier in this guide for singing tips.

;ﬁ Tuning

In Tuning, Auralia will play two notes. The second note is out of tune;
either flat or sharp. It may be only slightly out of tune, or it may be very out
of tune.
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Level Content
The two notes should be in unison, with slight pitch
Level 1 .
differences.
Level 2 The tuning will be more difficult.
Level 3 The two gives notes may be in unison, or a perfect
fourth, fifth or octave apart
Like level 1, only unison notes are used. You must
Level 4 .
attempt to correct the tuning of a note
Level 5 The tuning will be more difficult
Level 6 Correct the tuning between two notes in unison, or a
perfect fourth, fifth or octave apart

In levels 1 to 3, you must identify whether the second note is sharp, or flat.
When you have chosen, click on Sharp or Flat, and press OK. In levels 4 to
6, you must fix the tuning of the second note. Move the cursor in the middle
of the bar to the left if you wish to make the note lower, or to the right if
you wish to make it higher. (You can press the Play My Answer button to
hear the tuning as you have changed it during practise). You can move it
either by clicking on the cursor and dragging with the mouse, or by clicking
on the Sharper and Flatter buttons either side of the bar. When you are
satisfied with your changes to the tuning, press OK.
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Technical Support

Introduction

Before contacting Rising Software Technical Support, please consult this
User’s Guide and the online help. If you still cannot resolve your problem
or query, please contact Rising Software Technical Support through one of
the methods below.

When contacting Rising Software, please have the following details on
hand:

1. The version of Auralia you are using;
2. The version of Microsoft Windows you are using;

3. The type of sound or MIDI equipment you are using, and details of
your Auralia sound configuration, if it is a sound related problem;

4. Whether Auralia is installed on a network, and if so, which one;

5. What the exact problem is, such as the exact message given by
Auralia , what you were doing when the error occurred (eg
practising intervals, reviewing students’ statistics, etc), and any other
details you feel are relevant.

== World Wide Web

Rising Software maintains an Internet World Wide Web site at the
following address: http://www.risingsoftware.com. Consult our site before
using alternative forms of communication. Listing of known bugs and
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program updates will be listed there.

W% Electronic Mail

We can be contacted through email on the internet (and associated
networks) at the address: support@risingsoftware.com.

You are welcome to fax any correspondence regarding Auralia to us on +61
39481 3380. Please include a fax number if you wish your query to be
responded to by fax.

Telephone

You can reach the Rising Software office during business hours on + 61 3
9481 3320. If you are in the USA, please call (888) 667 7839. If we are
unavailable, please leave a message and we will return your call.

m Post

You can reach Rising Software by post at:

Rising Software Australia
3 Darling St

Fairfield, VIC 3078
AUSTRALIA




